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Information in this document is subject to change without notice and does not represent a 
commitment on the part of Software Bisque. The software products described in this 
document are furnished under a license agreement or nondisclosure agreement. They may 
be used or copied only in accordance with the terms of the agreement. It is against the law 
to copy the software on any medium except as specifically allowed in the license or 
nondisclosure agreement. The purchaser may make one copy of the software for backup 
purposes. 
 
No part of this manual and/or databases may be reproduced or transmitted in any form or 
by any means, electronic or mechanical, including (but not limited to) photocopying, 
recording, or information storage and retrieval systems, for any purpose other than the 
purchaser's personal use, without the express written permission of Software Bisque. 
 
This document was produced using Microsoft Word. 
 
© 1997, 1998, 1999, 2000 TPoint Software and Software Bisque. All rights reserved. 
 
CCDSoft CCD Astronomy Software and TheSky Astronomy Software are trademarks of Software 
Bisque. 
TPoint, TPOINT and TPOINT-PC are trademarks of TPoint Software. 
 
TPoint software is sold by Software Bisque under a licensing agreement with Patrick 
Wallace, Abingdon, Oxfordshire, United Kingdom.  
 
Windows is a trademark of Microsoft Corporation. Microsoft Word is a registered trademark of 
Microsoft Corporation. 
 
All other product names are trademarks of their respective owners and are used solely for 
identification. 
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Introduction  
Thank you for purchasing the Paramount GT-1100S Robotic Telescope Mount.  The 
Paramount is a high-precision instrument designed to deliver unmatched telescope 
performance to the amateur or professional astronomer.   
 
We recommend that you become familiar with all the components of the Paramount before 
attempting to assemble and use the instrument.  Although we have taken many steps to 
ensure ease-of-use, you will learn that there are many critical steps you must follow to 
obtain optimal telescope performance.  Please familiarize yourself with the parts and 
components diagrams before unpacking your new mount. 
 
A series of instructional videos (in MPG format) is provided on the Paramount CD-ROM. 
They can be viewed nonstop from the Installation program; for more control of the 
playback, double-click on the file from Windows Explorer so you can easily stop, rewind 
and re-play each instructional video. 
 
We strongly recommend that you study these videos as a first step toward learning how to 
use the Paramount.  
 
List of MPEG files located in the BIN folder on the Paramount CD-ROM 
 
File name Contents 
Unpacking.mpg Unpacking the Paramount GT-1100S 
Mounting1.mpg Attaching the Paramount to the pier 
Pier.mpg Software Bisque pier overview 
Baseinstr.mpg Base Instrument Panel overview 
Dec balance.mpg Balancing the declination axis 
Ra balance.mpg Balancing the right ascension axis 
Homing.mpg Homing the mount 
Polar altitude.mpg Adjusting altitude during polar alignment 
Polar azimuth.mpg Adjusting azimuth during polar alignment 
 
What Makes Paramount Different?  
The Paramount GT-1100S is designed from the ground up to be a sturdy, reliable mount 
for instruments up to 45 kg (100 lb). The following features insure increased productivity 
for astronomer using the GT-1100S:  
 
· Research grade right ascension gears with less than 5 arc-seconds of periodic error peak-

to-peak. 
· TheSky Astronomy Software, to easily locate your target objects. 
· CCDSoft CCD Astronomy Software, for controlling CCD cameras. 
· Orchestrate scripting program for running unattended data acquisition sessions. 
· TPoint Telescope Error-Modeling Software, to provide unmatched pointing capabilities. 
· Software Bisque’s MKS-3000 Telescope Drive System, for precise tracking, periodic 

error correction and slewing. 
· Accurate homing for quick startup 
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Unpacking and Assembling the Paramount GT-1100S 
 
The order of the assembly is important and the steps are listed here. A more detailed 
description follows. 
 

1. Unpack and inspect. 
2. Attach the mount to the pier. 
3. Attach the counterweight bar to the declination assembly. 
4. Add the counterweights. 
5. Attach the optical tube assembly (OTA). 
6. Balance the system. 
7. Connecting the electronics and power. 
8. Turn on and test the mount. 

 

Step 1 —  Unpacking the Paramount GT-1100S 
Software Bisque has made every effort to ensure that your new mount arrives just the way it 
left our facilities, ready to run.  We want your first experience with our product to be as 
enjoyable as the many hours you will spend with it under the night sky.   Upon receiving the 
shipping packages, please inspect all boxes for damage of any kind.  If you notice anything 
peculiar, make detailed notes before opening the packages (we recommend photographing or 
video taping the unopened packages if there is any apparent damage). 
 
Remove all components from the packing boxes and check to make sure they are in good 
order.  Also compare the pieces with the following Packing List.  

Packing List 
Quanti

ty 
Item 

1 Paramount GT-1100S 
3 5/16x18x1-inch pier mounting bolts 
1 1½ x18-inch counter-weight bar 
2 9 kg (20 lb.) ergonomic counter-weights 
1 Joystick 

 
For assembly at least the following are required (included): 
· 1/16, 1/8, 3/16 and ¼-inch Allen or hex wrenches. 

Paramount GT-1100S Assembly and Setup 
Once you have thoroughly inspected all components of the mount, you are ready to 
assemble the Paramount. Software Bisque pre-assembles and tests each mount individually, 
so the final assembly should go smoothly.  Follow the steps below to assemble the mount.  
 

Step 2 —  Attach Mount to Pier 
Loosen the six altitude adjustment nuts (two right ascension housing nuts and one 
adjustment bar nut on each side). Caution! When all 6 of these have been loosened, the 
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right ascension housing is free to pivot in the wedge. As shipped, the right ascension 
housing is in the lowest position and therefore has no tendency to fall. Once raised, make 
sure that at least two of the nuts are tight to insure the right ascension assembly does not 
fall. 

 
Figure 1—  Make sure the two shoulder bolts in the slotted holes to the North are in 
place before raising the Paramount to its highest altitude position, as it will have a 

tendency to fall towards the South in this configuration. 

 
Rotate the right ascension housing to the highest elevation and re-tighten the altitude 
adjustment bolts. When the right ascension housing is in this position, accessing the rear 
pier mounting bolt is much easier. Caution! When lifting the housing to attach the right 
ascension/wedge assembly to the pier, make sure the right ascension housing nuts are 
secure or the wedge will be unstable during the lift.  
 
Insert the three pier mounting bolts into the wedge-to-pier attachment holes shown below 
and hand tighten.  
 

 
Figure 2 —  Pier Attachment Holes 

 
Next, rotate the right ascension assembly to its highest position to make the pivot shoulder 
bolt more accessible. Now tighten the rear shoulder bolt until it is snug. When making 
azimuth adjustments, you do not have to loosen this rear shoulder bolt. 
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Figure 3 —  Preparing the Paramount Wedge for Mounting 
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Note the azimuth adjustment 
screws on the East and West sides 
of the mount. These screws are fine 
pitch and require a lot of turning to 
tighten (i.e. 28 turns per inch of 
movement). Continue to screw in 
the azimuth adjustment screws until 
they have contacted the shoulder 
bolts (the ends of these azimuth 
adjustment screws become visible in 
the slotted holes shortly after they 
have passed through wedge side 
plate). 

 
 

 

 

 

 

 

 

Step 3 —  Attach Counterweight 
Bar to Declination Housing 
Locate the counter-weight bar and screw 
the threaded end into the base of the 
declination housing. Although this 
increases the weight of the assembly 
before it is lifted for attachment to the 
right ascension housing, it provides a solid 
handle for lifting the declination axis.  
 
WARNING: If the right ascension worm 
is not engaged with the right ascension 
gear, the declination assembly is top-
heavy and could cause damage when it 
falls. See picture on the left.  
 
If a counterweight is added the mount 
bottom heavy and is in a stable 
configuration. See picture at right. 
 

Azimuth adjustment screws
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Approximating Polar Elevation 
The following table can help you estimate the height right ascension housing measured 
from the bottom of the wedge assembly.  
 
Here is the equation for determining the height of the center of the socket head cap screw 
on the GT-1100S: 
 
Polar height = 1.75" + 7.75" * sine( Latitude ) 
 

Latitude 
(degrees) 

Height of SHCS 
center (inches) 

Height of SHCS 
center (cm) 

20 4.40 11.2 
22 4.65 11.8 
24 4.90 12.5 
26 5.15 13.1 
28 5.39 13.7 
30 5.62 14.3 
32 5.86 14.9 
34 6.08 15.5 
36 6.31 16.0 
38 6.52 16.6 
40 6.73 17.1 
42 6.94 17.6 
44 7.13 18.1 
46 7.32 18.6 
48 7.51 19.1 
50 7.69 19.5 

 

 

 

 

 

 

 

Step 4 —  Add the Counterweights 
While the right ascension gear and worm are still not in contact, the counterweights should 
be placed on the counterweight bar. Note that each counterweight has a brass insert that is 
used to apply pressure between the counterweight and the declination shaft. This insert 

Po
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t
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does not turn while pressure is applied by turning in the knob, protecting the counterweight 
bar from scratches.  
 
Add the estimated amount of counterweight before attaching the optical tube 
assembly! 
 
The amount of counterweight depends on the weight of the optical tube assembly. Try to 
make a close estimate to how much counterweight is required and add this to the 
declination counterweight bar. Once added, the right ascension axis will be bottom heavy 
yet will be in a safe state since the axis is free to hang downward due to gravity. Adding the 
optical tube assembly will now result in a system that is close to balance. 
 
After the counterweights are added, firmly tighten each of the counterweight knobs to 
insure the weights do not slip. Also make sure you add the counterweight safety stop on the 
bottom of the counterweight bar.  
 
Be very careful when handling the counterweights so that you do not accidentally drop them. They are heavy 
enough to make a dent in concrete, so imagine what they could do to your foot! 
 
 

Step 5 —  Attach the Optical Tube Assembly 
Because the Paramount can accept a wide range of optical tube assemblies, not all of the 
options are discussed here. The LosmandyTM Dove tail system is one popular system for 
attaching optical tube assemblies.  
 
Warning!  

Please note the difference between the Paramount adapter plate and other 
dovetail systems.  
 
Some dovetails (such as those supplied with Celestron telescopes) are not 
captive when placed in the Paramount dovetail plate until the angular contact 
setscrews are tightened: 
  

Celestron Dovetail

Celestron Dovetail

Paramount adapter plate

Paramount adapter plate

Captive only when set screws 
are tightened against dovetail!
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Once attached, remember that the right ascension axis is free to rotate and if top heavy 
(that is, the OTA is heavier than the counterweights) the mount is in a dangerous and 
possibly destructive state. Continue to hold the assembly and spin it using caution to 
determine the balance. By holding on to the counterweight bar, you can make adjustments 
to the weight distribution and also prevent the OTA from falling and colliding with the 
mount. Continue to make adjustments to the position of the counterweights until you can 
release the declination axis and it remains at rest or rotates very slowly. 
 

Attaching the Optical Tube Assembly 
Depending on the size and weight of your optical tube assembly (OTA), you might want to solicit a 
friend (or two) to help lift and attach this component.  The Losmandy dovetail mounting 
brackets provide a stable mounting interface for most off-the-shelf OTAs.  Be sure to 
sufficiently tighten all mounting screws. 
 
To limit the amount of stress placed on the right ascension gear teeth while attaching the 
OTA to the declination plate, the right ascension axis should be rotated so that the 
counterweight bar is vertical as shown on the diagram. Then estimate the amount of 
counterweight that is required and place it on the counterweight bar. In this manner, the 
out-of-balance system is in a static state and the gear teeth are not supporting the entire 
load of the counterweights. Once the counterweights are in place, the OTA can be attached.  
 
Care should be taken to center the mass of the OTA near the center of the declination axis. 
Depending on the type of hardware used to attach the OTA to the declination axis, this 
adjustment can be made during attachment or by moving mounting rings prior to lifting the 
OTA to the declination plate. 
 
 
Tube Rings 
Tube rings provide a means of adding a second optic on top of the primary optic. They can 
also provide a more robust system for mounting the primary optical tube assembly than 
dovetail systems.  
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Caution: Do not put the Paramount in the above configuration with the 

worm gear engaged 
 

Note: The Paramount, as pictured above, is in an unstable configuration that puts extreme 
forces on the right ascension gear teeth. The counterweight shaft should remain in the 
vertical position during the time when the Paramount is loaded with counterweights but the 
OTA has not been attached. This minimizes the force on the right ascension gear teeth and 
insures the mount is in a stable position at all times. 
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Step 6 —  Balance the system 
Attach your CCD camera and all other equipment (focuser, dew heater, etc.) to the optical 
tube assembly while balancing the mount.  The telescope will track and slew best when 
properly balanced. An unbalanced system can cause numerous problems, such as stalling or 
“gear chattering” during slews.  There is no clutching mechanism on the Paramount. This 
means that balance is achieved by disengaging the worm from the gear in each axis.  
 
Caution! 
Use extreme care when balancing the telescope!   Make note of the weight 
distribution on the telescope before pulling the worm block assemblies away from 
the gears. Always grab hold of the OTA or counterweight arm before disengaging 
the worm and gear so that you maintain control of the telescope.  
 
The telescope could be damaged, or you could be seriously injured whenever the worm gear 
is disengaged from the main gear on an unbalanced system.  
 
The Paramount comes with two 9 kg (20 lb.) counterweights to balance the optical tube 
assembly.  To balance the right ascension axis, slide the counterweights up or down the 
counterweight bar until the system has no tendency to fall in either direction.  
 
If you use multiple devices, such as a video camera to map and a CCD to image after 
mapping, the difference in weight might be enough to cause slewing problems when the 
instruments are interchanged. By marking various positions of counterweights on the shaft 
for different configurations, you can quickly rebalance a system without disengaging the 
worm and gear. It is very important not to change the system after mapping has been 
completed and a model is created for the mount/OTA. 
 
The worm blocks on the GT-1100S provide a mechanism for disengaging the worm from 
the gear and holding this configuration while balancing. Though it is always a good idea to 
have a second person available for aid in holding the OTA during balancing, this 
mechanism allows for single person balancing.  
 
To access the worm blocks the worm block covers must be removed. Each worm block has 
the following threaded items:  
 
· A spring plunger to provide engagement between the worm and gear. 
· A safety screw that prevents the worm and gear from disengaging.  
· A disengagement retaining screw for holding the worm block away from the gear.  
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Safety screw Spring plunger

No adjustment

Disengagement retaining screw

 
 
Spring Plunger 
The spring plunger assures full contact of the worm and gear. Though the motors on the 
mount can slew with this plunger set to a wide range of pressures, the optimal pressure can 
be achieved by rotating the spring plunger clockwise until it is in hard contact, then rotating 
counterclockwise one and one-half full turns.  
 
Safety Screw 
To fully disengage the worm from the worm block for balancing purposes, the safety screw 
must be rotated counterclockwise about two full turns. To properly reengage the safety 
screw, turn it clockwise until it stops and then rotate counterclockwise about 1/8 of a turn. 
Verify the safety screw is properly adjusted by pulling the worm away from the gear. It 
should move slightly but not disengage.  
 
Disengagement Retaining Screw 
This screw is used only while balancing a system. To hold the worm away from the gear 
while balancing, tighten this screw while holding the worm block away from the gear. Once 
tightened, you can release the worm block and it will not spring back into mesh with the 
gear.  
 
If two persons are available for balancing, it is not necessary to use this screw to hold the 
worm block away from the gear as one person can do this.  
 
Note: Now is the best time to mark the various positions the counterweights will be for different instrument 
configurations.  
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Counterweights for the Paramount GT-1100S with Sure-GripTM  
 

 
 
The counterweights for the GT-1100S have the following features.  
· 9 kg (20 lb), all stainless steel.  
· Sure-Grip technology. The central bore has a unique profile that provides much more 

locking friction than a simple straight through bore. Hand tightening provides enough 
torque to insure zero slippage.  

· Ergonomic feel with smooth radius corners.  
· Stainless locking handle has a very low profile that is protected in a recessed bore.  
· Counterweight can be tightened by hand or using a hex wrench.  
· The brass locking-plunger is spring loaded to make adding and removing counterweights 

easy.  
 
 

Step 7 —  Connecting the Electronics and Power 
1. Connect the Joystick to the round din connector on the East side of the Paramount 

right ascension box. Never plug or unplug the joystick while the Paramount is 
powered. 

2. Plug the serial cable into the appropriate connector on the Base Panel (Serial). This 
connection permits communication between the Paramount and the computer.  

3. Plug the 48-volt power supply into the jack labeled “Mount” on the Base Panel. This 
supplies power to the Paramount. 

4. Turn on the Paramount using the rocker switch above the Joystick connection on the 
East side of the mount.  

 
On power up, you will hear the motors seeking up to six minutes of arc for the nearest 
index on the encoders.  
 
We recommended additional devices through the “Base Panel-to-Instrument Panel” cable 
routing system remain unattached until you are comfortable that the mount is connected to 
the computer and operates as expected with the joystick and under computer control.  
 

First Slews 
Once you have assembled the mount and connected all the electronic wiring, verify that all 
the electronic and mechanical components function by slewing the mount.   
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Note: The Paramount GT-1100S will not slew or begin tracking 
until it is homed! 

 

What Is Homing?  
Homing involves rotating the each axis of the Paramount until the homing index is located. 
Each axis has an infrared sensor that is used to detect the home position. The home 
position is at approximately hour angle 1.2 and declination –30 degrees. This position 
cannot be changed as it depends on the physical position of the gears.  
 
Each time the mount homes, it returns to the exact position and sets the position registers 
to zero. When synchronization is performed, the hour angle and declination of the home 
indexes are stored in the internal flash of the Paramount. Subsequent sessions simply use 
the Local Sidereal Time to determine the pointing direction of the mount.  
 
The homing function of the Paramount GT-1100S provides the following benefits to the 
astronomer including the following:  
 
· Once a mount is polar aligned, you can achieve extremely accurate pointing by simply 

homing then using the Paramount under control of TheSky.  
· After homing the mount “knows” where the limits are and the mount cannot be driven 

into itself. The right ascension limits are just past the Meridian in each direction (east 
and west) and in declination the limit is at approximately –90 degrees declination. In 
right ascension, this is about 1.2 hours away from the Meridian with the telescope 
pointing to the West (hour angle 1.3). In declination, the homing position is at 
approximately –30 degrees declination.  

· The PEC function uses this information to calibrate the internal PEC table with the 
orientation of the worm.  

· You can quickly recover from power loss to the mount or other personal computer 
malfunctions using the homing feature.  

 
Homing the mount using the Joystick 
To home the mount using the joystick, “double click” the button on top of the joystick. It 
is very important that you do not move the joystick while clicking. As a safety feature, you 
can abort the home in either axis by moving the joystick from the center position. It is easy 
to stop the homing process by accidentally moving the joystick during a home.  
 
Homing the mount using TheSky software  
Upon establishing a link with the Paramount GT-1100S, TheSky will prompt as to whether 
or not the mount should be homed if it detects that the mount has not already been 
homed.  
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The Joystick 
In addition to homing the mount, the joystick is used to manually move the Paramount 
GT-1100S. It also has a built-in LED flash light for use at the telescope.  

 

 
 
Moving the Paramount with the Joystick 
Left and right motion moves the telescope in Right Ascension and up and down motion 
moves the telescope it in declination. The speed of the mount will increase the further the 
joystick is moved from the center position. A total of 16 different speeds are traversed as 
you move the joystick from center all the way to the edge. The first two are slower than 
sidereal rate, and they increase up to the maximum speed, as entered in the MKS-3000 
Setup Dialog.  

Software Bisque’s MKS-3000 Control System 
 

The MKS-3000 Control System Dialog Box 
The “factory” defaults for the Paramount’s control system allow operation right out of the 
box, and typically there is no need to make changes to these settings. However, the control 
system is very powerful and offers many options, so the default setting of many functions 
can be altered.  
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Figure 4 —  Setup Tab’s on the Object Information Dialog Box 

 
The Setup Tab allows you to change some of the default options of the Paramount’s 
control system. It is recommended that you do not make changes to any of the values 
unless you have a clear understanding of how the change will effect the mount’s operation. 
For example, if you set the Minimum Limit to –4,000,000 instead of -3,250,000, the mount 
may collide with the right ascension stop if the mount is under joystick control or PC 
control.  
 
Note that the two dialogs boxes pictured above show the Right Ascension and Declination 
default settings.  
 
Mount Type 
The Paramount is a German Equatorial telescope, so this option should be set to German 
Equatorial, not Fork.  
 
Mount ID 
This information is for reference purposes only.  
 
Maximum Speed 
The motors are capable of moving the Paramount at approximately 8 degrees per second in 
declination and 6 degrees per second in right ascension. To move at the fastest rate, enter a 
value of 100% on this input. For large telescopes, these slew speeds are quite fast and values 
of 50-80% are suggested to minimize wear on components.  
 
Track rate 
This input allows you to alter the tracking speed from the sidereal speed. A value of 100% 
will rotate the mount at the sidereal rate.  
 
Non sidereal rate 
If you wish for the mount to slew at a rate that is separate from the sidereal rate but 
cumulative to it, you can enter a value here in arc-seconds per second. If you choose a 
minor planet and select Set Tracking Rate from the Telescope tab, the non-sidereal rate will 
be set in both right ascension and declination. To set the tracking rates back to normal 
sidereal, simply click on a star and choose Set tracking rates.  
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Figure 5 —  Click the Set Tracking Rates button to track on minor planets, planets 
and comets. 

 
Minimum Limit, Maximum Limit 
You can set the software limits for each axis to insure the telescope does not attempt to 
slew through a hard stop. The right ascension limits are visible by looking at the South side 
of the mount. The declination hard stops are set at –90 declination (or 90 declination for 
those “down under”). When set properly, it is impossible to run the mount into a stop as 
the motor will decelerate to internal limit.  
 
Guider Speed 
This option adjusts the speed at which guider corrections move the motors. The units are 
fraction of sidereal rate so 0.50 is half of the sidereal rate.  
 
Compute 
This button simply computes the integer sidereal rate and displays it on the setup dialog for 
diagnostic purposes.  
 
Sensor Hour Angle and Sensor Declination 
When the Sync command is performed, the hour angle and declination of the Home 
Position are computed and stored in the flash memory of the control system. For the 
Paramount GT-1100S, these values are approximately hour angle=1.2 hours and declination 
= -30 degrees for a mount that is leveled and polar aligned.  
 
If for example you choose the Sync command from the Telescope tab when the telescope 
is actually pointed to a star other than the one shown in the Object Information dialog, 
then these values will be incorrect.  
 
Note that the following three options work on a single axis basis. If you change the 
maximum slew rate percentage for right ascension and then choose Save In Flash, only the 
right ascension axis is changed and stored.  
 

Save in Flash (single axis) 
When changes are made to the values on the Setup screen, they will remain active 
until the mount is powered down unless Save in Flash is chosen. It is important to 
note that while the values are saved into flash memory, the motors are stopped. This 
does not mean that position information is lost, just that the telescope will stop 
tracking at the sidereal rate momentarily.  
 
Home (single axis) 
Select this command to home a single axis.  
 
Defaults (single axis) 
Selecting this command sets all of the values for the control system to the defaults 
values for the GT-1100S.  
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Copy Parameters 
Choosing this option will copy all of the settings for the control system to the clipboard. 
You can then paste them into a word processor or the windows notepad application for 
viewing. You may be asked to email this information to Software Bisque if there is an issue 
with the control system. Following is a sample of the information that is copied to the 
clipboard when this command is used. The comments after the “//”on the right were 
added.  
 
MKS-3000 Telescope Control System Copyright (c) 2000 Software Bisque  
Mount ID: Paramount GT-1100S 
***************** Axis 0 Control version: 0.9.92  *****************  // right ascension 
axis 
Mount Type: 0 
Base rate: -20187780 
Max speed: 900000000 
Acceleration: 300 
Non sidereal rate: 0 
Minimum Position Limit: -3320000 // This may be different for your mount 
Maximum Position Limit: 390000 // This may be different for your mount 
HA/Dec:    1.2000   // This is altered each time a sync occurs 
Guide: -315434 
Tics per rev: 7200000 
PEC ratio: 10 
Maximum position error: 1000 
Unit ID: 100 
EMF Constant: 96 
Index angle: 684   // Motor dependent, yours may be different 
Home velocity high: 500000000 
Home velocity med: 90000000 
Home velocity low: 3000000 
Home dir, sense: 1100 
Home mode, required, Joystick, In-out-in: 1111 
Home Index Offset:         0 
PEC cutoff speed: 40375560 
Max Voltage: 15 
Max Gain: 150 
 
***************** Axis 1 Control version: 0.9.92  ***************** 
Mount Type: 0 
Base rate:         0 
Max speed: 900000000 
Acceleration: 300 
Non sidereal rate: 0 
Minimum Position Limit: -3500000 
Maximum Position Limit: 630000 
HA/Dec:  -29.9825 
Guide: -189260 
Tics per rev: -4320000 
PEC ratio: 10 
Maximum position error: 1000 
Unit ID: 100 
EMF Constant: 96 
Index angle: 673   // Motor dependent, yours may be different 
Home velocity high: 500000000 
Home velocity med: 90000000 
Home velocity low: 3000000 
Home dir, sense: 1100 
Home mode, required, Joystick, In-out-in: 2111 
Home Index Offset:         0 
PEC cutoff speed: 0 
Max Voltage: 15 
Max Gain: 150 
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Training PEC 
This function is run when a CCD autoguider is making guiding adjustments to the system. 
The PEC training period takes about four minutes to complete. During the PEC training, 
the graph will be updated showing the progress and adjustments.  
 

 
Figure 6 —  Periodic Error Correction Tab on the MKS 3000 Dialog Box (TheSky) 

 
 
The following steps are necessary to successfully train PEC:  

1) Display the PEC dialog by choosing Telescope Options More settings.  
2) Switch to CCDSoft and start guiding.  
3) Switch back to TheSky and choose Start Recording.  
4) Wait until the red status line has cross the entire graph (about 4 minutes) and the 

“Abort Recording” button switches back to Start Recording.  
 
It is important to note that the recording phase of the PEC training only records the values. 
It does not automatically store them in the flash or activate PEC adjustments. Unless the 
seeing is very good and the autoguiding settings are optimal, the recorded PEC values will 
contain a considerable amount of noise and must be smoothed before the Upload 
command is used to transfer the recorded table into the PEC memory on the Paramount.  
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MKS Status Dialog 

 
Figure 7 —  The Advanced Tab of the MKS 3000 Dialog Box (TheSky) 

 
This dialog is provided simply for diagnostic purposes. The encoders’ position (in encoder 
tics) is shown for each axis. Other status values are shown that indicate the state of the 
motors and control system.  
 
The graph near the bottom of the dialog is a very small sampling of the encoder positioning 
vs. desired encoder position.  
 
 

The MKS Advanced Dialog 
 
 

 
Figure 8 —  The Advanced Tab of the MKS 3000 Dialog Box (TheSky) 

 
This dialog is normally hidden and does not appear by default. The values present on this 
tab of the dialog are critical to proper operation of the mount and should never be altered 
unless the reason for making the change is perfectly understood.  
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Figure 9 —  The Paramount Instrument Panel 
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Figure 10 —  The Paramount Base Panel 

The First Night 
You should already be very familiar with the operation of TheSky Astronomy Software and 
the TPoint Modeling software before attempting to use these two applications “under the 
stars.” If you are not familiar with these applications, please refer to their documentation for 
further information. 
 
Selecting the GT-1100S from TheSky 
The Paramount GT-1100S uses the MKS-3000 control system from Software Bisque. Make 
sure you do not select Paramount GT-1100 from the list of telescopes, as the prior version 
of the Paramount used a different control system.  
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Figure 11 —  Telescope Setup and Settings Dialog Boxes 

 
Connecting the Paramount to your Computer 
The Paramount communicates through a serial port on your computer.  Make sure the 
MKS-3000 is configured for the correct computer port. From TheSky, click Settings on the 
Telescope Setup dialog box.  
 

Syncing on a Star 

 
Figure 12 —  The Telescope Tab on the Object Information Dialog Box (TheSky) 

Once the mount is up and running and you have estimated the polar alignment, you can 
Sync on a star to initialize the mount. The Sync button can be found in the Object 
Information dialog on the Telescope tab.  
 
While you are aligning the mount to the pole, you will be syncing the mount several times. 
Once the mount is aligned with the pole, you will not have to sync again unless you change 
optical tube assemblies or somehow alter your setup otherwise in a significant manner.  
 
Following is a short overview of what transpires when Sync is clicked.  
 
The mount was homed before the sync so the angles are computed between the home 
position and the current position of the mount when the sync occurs. Using these angles, 
the hour angle and the declination of the home position is computed and stored inside the 
Paramount’s flash memory.  
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By accessing the stored hour angle and declination of the mount and using the computed 
Local Sidereal Time, TheSky can compute the current pointing location of the telescope. In 
fact, it should point identically on subsequent sessions as it does on this session.  
 
As a quick test, turn of the mount, then turn it back on and home it. This will cause the link 
between TheSky and the mount to be lost.  
 
When you re-establish the link with the mount, you will see the crosshairs appear on the sky 
display at the current location of the home position. Now slew the mount to the star you 
synced on, and it should fall in nearly the same place in the eyepiece, video or CCD that you 
are using. In practice there are small movements due to mirror flop or slight time 
differences so the star may not be in exactly the same position, but it should be very close.  
 

Polar Alignment 
Before the Paramount can accurately track objects, an accurate polar alignment is necessary. 
The question may be asked “how accurate”. Subjectively, if the altitude and azimuth are 
each within 2 arc-minutes of the pole, images of a few minutes can be taken maintaining 
round stars at focal lengths of 2000mm or so. At greater image scales and longer exposures, 
guiding will become necessary where adjustments in both altitude and azimuth are made. 
Once an axis is within one arc-minute of the pole it becomes difficult to improve since 
making the adjustments requires altering the mount from a fixed state to a free state then 
back to a fixed state again. 
 
Adjusting the Altitude and Azimuth  
The Paramount is equipped with precise altitude and azimuth adjustments.  The 28-pitch 
adjustment screws are specially designed so that one complete rotation translates to a small 
angular motion.  One rotation of the Altitude Adjustment Screw results in about 16 arc-
minutes of motion.  One rotation of the Azimuth Adjustment Screws results in about 18 arc 
minutes of motion. These calibrated amounts can be used to fine-tune the polar alignment. 
 
When the telescope and counterweights are in place, it is necessary to reduce the pressure 
on the altitude adjustment screw by lifting up on the declination housing. Using one hand to 
apply upward pressure and the other to turn the knob works well in practice.  
 

Polar Elevation Adjustments 
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Figure 13 —  Paramount Elevation Adjustment Screws 

 
Important Note! 
Before loosening the four right ascension housing nuts, be certain that the two nuts on the 
altitude adjustment bar are securely tightened. If they are not, the entire assembly, including 
the telescope, is free to move and will fall to the bottom of the wedge slot. This could cause 
damage to the Paramount, the OTA or the operator. 

 
 

Polar Azimuth Adjustments 
For a complete closed-loop polar alignment adjustment system, attach a video camera to the 
telescope and point the telescope near the celestial equator*.  The video output gives real 
time feedback of any adjustments made.   If you have calibrated the video output display 
(i.e. arc-minutes in the x and y directions), you can determine precisely how much the 
telescope moves during adjustments and rapidly achieve polar alignment. 
 
*Note:  When making adjustments for polar alignment using video feedback, make sure the 
OTA is pointing close to zero degrees declination.  Along this line, the units of angular 
distance match the units of right ascension.  As the telescope moves closer to the poles, the 
angular distance swept by the telescope becomes smaller for a given change in right 
ascension. 
 

Polar Alignment Using TPoint  
Once you have successfully performed a mapping session and developed a TPoint model, 
you can use TPoint to determine the mount’s polar alignment.  Use the values computed by 
TPoint for the Polar Axis Elevation and Polar Axis azimuth (EW) to make the necessary 
adjustments to the Paramount’s Altitude and Azimuth Adjustment screws. Usually two 
iterations can get each axis within two arc-minutes.  
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Getting Started Using TPoint 
Once you are familiar with the technique of telescope mapping as described in the TPoint 
User’s Manual, you are ready to begin a telescope-mapping run.  If the Paramount’s polar 
alignment is way off, even short star-hopping slews may require the destination star to be 
re-centered in the eyepiece. 
 
Telescope mapping and polar alignment procedure 
1. Set your time as accurately as possible each night before observing. 
2. Insert a New TPoint model into TheSky (Edit  > Insert > TPoint Model). 
3. Synchronize the telescope on a bright star. When performing a TPoint run synchronize 

the telescope once for each mapping run.  Synchronizing more that once will require a 
new TPoint model. 

4. After accurately synchronizing the telescope, slew to a nearby star (by identifying the 
star in TheSky and clicking the Slew To button), center the actual star in the eyepiece, 
and then click the Map button on the Object Information dialog box.  This constitutes 
one data point. 

5. When you have mapped six data points that are close together in the sky, TPoint can 
begin correcting for errors in the mount and the pointing will improve.  Now, you’re 
ready to begin mapping stars over a larger portion of the actual night sky. 

6. After 15-20 data points are collected, add more terms to the TPoint model so that the 
RMS value is as small as possible.  Consult the TPoint User’s Manual for instructions on 
adding terms to a TPoint model. 

7. From TPoint, determine the current polar alignment of the telescope by clicking Model 
> Polar Alignment Information. 

8. Adjust the mount according to the TPoint polar alignment information. 
 
Delete the TPoint model and start over from Step 2. To remove the red Reference Lines 
that are created for each mapping run, from TheSky, click Data > Add User Data 
Remove All. 
 
In practice, using at least 20 stars distributed over half of the sky will provide enough 
information for the first iteration. Note that TPoint generates a statistical model and the 
values it generates for each of the terms is not an exact value and the correctness of each 
term is dependent on the entire model. If for example, there is a large non-perpendicularity 
of the declination axis and the telescope axis and the CH term is not turned on, the entire 
model will suffer.  
 
The polar misalignment errors are reported on the Polar Alignment Information Dialog in 
TPoint. Choose Model Polar Alignment Information to display the dialog. The fine pitch 
adjustment screws on the elevation and azimuth result in about 15 arc-minutes (300 arc-
seconds) per full turn.  
 
The above information can also be extracted from the Fit Dialog as explained below. 
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Figure 14 — Sample Polar Alignment Information Dialog Box (TPoint). 

 
The Polar axis elevation value (ME) and the Polar axis EW value (MA) provide an 
estimation of the polar misalignment in arc-seconds. 

 
TPoint Fit Dialog Meaning Action 
ME positive (+) Axis is below celestial 

pole 
Raise elevation 

ME negative (-) Axis is above celestial 
pole 

Lower elevation 

MA positive (+) Axis is East of celestial 
pole  

Move axis West (tighten West 
and loosen East) 

MA negative (-) Axis is West of celestial 
pole 

Move axis East (tighten East 
and loosen West) 

 
For example, if the Polar axis elevation (ME) value is +600 arc-seconds, the polar axis 
should be lowered about ten arc-minutes. Ten arc-minutes corresponds to about two full 
turns of the elevation adjustment screw.  
 
Similarly, when adjusting the polar axis azimuth, look at the Polar Axis EW value reported 
on the Fit Dialog. If this value is greater than zero, the pole of the mounting is to the right 
of North so the azimuth adjustment screw on the West should be tightened to move the 
pole towards the West.   
 
For most U.S. latitudes, the actual polar elevation target is not the North Celestial Pole but 
rather a point about one arc-minute above it to minimize the effects of refraction on longer 
exposures.  
 

Polar Alignment —  The Drift Method 
The drift method is an alternative method to achieve polar alignment.  Using this procedure, 
you can achieve very good polar alignment in each axis, though it will probably require 
considerably more time than using TPoint.  
 

Drift Method - Azimuth Adjustment 
Locate a star near the meridian (star should be > 15 degrees altitude and < 85 
degrees altitude). 
Determine if the star drifts north or south.  If the star drifts north, the polar axis is 
too far west. 
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If the star drifts south, the polar axis is too far east.  Make the appropriate 
adjustment and repeat the above procedure until the star does not drift for several 
minutes. 
 
Drift Method - Elevation Adjustment 
Locate a star near the eastern or western horizon (about 15 degrees altitude) at an 
hour angle of about 6H. If the star is in the east, drift to the north means that the 
polar axis elevation is too high, while drift to the south means that polar axis 
elevation is too low.  If the star is in the west, reverse these.  Continue making 
adjustments until the star does not drift for 10-20 minutes. 

 
Once you are familiar with TPoint, it provides the best analytical method for determining 
polar alignment. However, until a TPoint model is established with all of the terms 
necessary to achieve good pointing, the polar misalignment terms provided by TPoint are 
sometimes misleading. Again, using 20 or more stars distributed over at least half of the sky 
should provide good estimates of the actual polar alignment.  
 
Using a Calibrated Video Screen 
Although the adjustment screws on the Paramount wedge provide a reasonably accurate 
means of making adjustments to the polar axis, there are advantages to watching a calibrated 
video monitor while making small adjustments (less than 5 arc-minutes).  
 
The process of loosening the two shoulder bolts for azimuth adjustment or the right 
ascension housing nuts for altitude adjustment will usually cause a bit of motion of the 
entire Paramount. With video feedback, the magnitude and direction of this motion can be 
noted and then compensated for when re-tightening occurs. This small amount of motion 
(usually within a couple of arc-minutes) is not a problem when making course adjustments 
but becomes important when trying to achieve a polar alignment of less than three to four 
arc-minutes.  
 
When using video feedback for making polar alignment adjustments, pick a star near the 
celestial equator within an hour of the Meridian.  

Paramount Initialization  
This section describes the steps necessary to initialize the Paramount GT-1100S on the first 
night of operation and on subsequent nights.  
 
Tip 
The discussions related to TPoint modeling, mount initialization, parking, and so on, may 
seem daunting at first and leave you with the feeling the Paramount is a complicated system 
to use. These steps are necessary to achieve consistent, accurate pointing from night to 
night. In turn, accurate pointing allows enhanced functionality such as scripted operation 
and imaging without the burden of centering objects. Remember, if you wish to simply 
dead-reckon for an evening without mapping, simply Sync the telescope and go! 
Paramount’s pointing will continue to be better than most commercially available robotic 
telescopes.  
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For the Paramount to point accurately from night to night, there are a number of 
requirements that must be met. The amount of time saved when target objects consistently 
fall into the field of view warrants the additional steps needed to accomplish this. Once you 
have been through the entire process a couple of times, Paramount initialization will not 
seem as confusing as it might the first time. 
 
Homing 
The mount is homed at startup so that the mount is initialized in exactly the same position 
each time it is used. The homing function of the Paramount provides many benefits to the 
CCD imager: 

? ? Homing permits soft limits so the mount never crashes into itself, even if an 
improper star synchronization occurs.  

? ? Once a mapping run has been completed, it will continue to provide excellent 
pointing with ever having to perform a star synchronization.  

? ? Even if power is lost to the Paramount, the homing function can return the 
telescope to its previous state.  

? ? A reality check is performed when the star synchronization is performed to be sure 
the time entered in TheSky is reasonable.  

 
Once the mount is homed and a TPoint model is present, subsequent sessions only require 
accurate time to achieve excellent pointing.  
 
In the table below, each of the operations that are required for performing an initialization 
are listed along with the time needed to accomplish the operation. Please note that the time 
estimates listed for mapping are for an experienced user. The very first time you perform a 
mapping run might take considerably longer. 
 
As you can see, the mapping operation is the most time consuming. The short mapping run 
is identical to a normal mapping run except that only 6-12 stars are must be mapped.  
 

Operation Time required for an experienced user 
Setting the computer clock 2 minutes 
Performing a mapping run 20 to 120 minutes (using video) 
Performing a short mapping 
run 

5 to 15 minutes 

Homing 0-2 minutes 
 
Why is accurate time important? 
You can achieve very accurate pointing during a single session without having an accurate 
time base (i.e. within a couple of minutes). However, TheSky makes decisions on how to 
slew to various positions in the sky based on the local time. Objects that are to the East of 
the Meridian require the telescope to be on the West and vice versa (except in the “below-
the-pole” case).  
 
Always do a quick reality check of the computer’s time by comparing the simulated 

sky to the night sky! 
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A very accurate time base is required when initializing Paramount. TheSky uses the 
computer time to compute accurate Local Sidereal Time (LST). When a link is established 
between TheSky and the Paramount that has been homed, the LST is used to re-establish 
the synchronization between the Paramount electronic setting circles and the celestial 
sphere to within a few arc-seconds. Being able to simply power-up and start imaging makes 
each evening more productive.  

Setting the Computer Clock 
From TheSky, click Data > Site Information and select the Date and Time tab to access 
the Time Service function of TheSky.  This is the best method for setting the computer’s 
clock accurately. If you cannot use the “dial-up” Time Service feature of TheSky, you can 
set the time manually. Remember, each second of time translates to 15 arc-seconds of 
motion near the celestial equator. If the night-to-night time base is not set accurately, 
pointing will be compromised. The time error will be cause objects to fall a consistent 
amount in right ascension ahead or behind the target. There are also many web-based 
programs that accurately set the computer’s clock.  

Parking the Paramount GT-1100S 
Before parking the Paramount, you need to set the preferred park position for your 
telescope. This position (in altitude/azimuth coordinates) is stored to a file named 
paramnt.cfg. For example, if you have a roll-off roof observatory and the roof can only 
close when the telescope is in a particular orientation, the Set Park Position command is 
used to define that orientation. Then, each time a Park command is issued, the mount will 
slew to the park position.   
 
Setting the Park Position 
With a telescope link established, first slew the telescope to the desired position. Next, from 
TheSky, click Telescope > Options > Set Park Position.  
 
We recommended that the telescope be parked as close to the home position as practical. 
Since the Paramount must be homed at power up; the time required to find the home 
position is reduced when the park position is near the home position.  
 
Parking the GT-1100S 
Click Telescope > Options > Park.  
 

Syncing the Telescope 
Syncing the telescope involves pointing the telescope system at a known object (usually a 
star) then pressing Sync from the Telescope Tab on the Object Information dialog box.  
 

The date, time and location in the Site Information dialog in TheSky must be 
entered correctly before telescope synchronization is performed! 
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Figure 15 —  Sample Object Information dialog box and Telescope Tab (TheSky) 

Steps for performing a telescope synchronization 
1. Choose a bright star in the sky that you definitely can identify (partial clouds or twilight 

can make this more difficult than it seems).  Make sure the star is on the correct side of 
the Meridian. The counter-weights should never be higher than the telescope when a 
Sync is performed. 

2. Use the preferred method for mapping (video, reticle eyepiece or CCD) to center the 
object. 

3. From TheSky, click Edit > Find (or click on the object) to display the Object 
Information dialog for the bright star. 

4. Click Sync on the Telescope tab of the Object Information dialog box. When the 
confirmation dialog appears, click OK*. 

 
Note: if the Confirm Syncs option on the Telescope Setup dialog is clear, you will not be prompted to 
confirm the synchronization. We strongly recommended that the Confirm Syncs option is always marked, 
since accidentally clicking Sync instead of Map during a mapping run is easy (especially at 3:00 a.m.!). 
 

The Meaning of Sync 
Once you have synced the telescope, TheSky now knows the orientation of the telescope 
and can ascertain how to correctly slew the telescope to reach any position in the sky 
without wrapping up cables or running the telescope into the mount. This of course also 
requires the site information is properly entered in TheSky. 
 
When the Sync is performed, the relevant information needed by TheSky to automatically 
startup on subsequent sessions is stored in the flash memory of the Paramount. If a 
different computer is to be used on subsequent nights, you must copy the .SKY file to the 
folder containing the file named SKY.EXE.  
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In theory, the Paramount is synced once and never again.  In practice, you will be syncing 
the system from time-to-time. Following are a few examples of changes that will require a 
Sync and subsequent mapping (or short mapping) run: 
? ? Changes to polar alignment (requires a full TPoint mapping run).  
? ? Changing the optical tube assembly. 
 
 

 
Figure 16 —  Telescope Setup Dialog Box (TheSky) 

 

Telescope Mapping Overview 
Telescope mapping is the process of slewing to a known object, manually centering that 
object in the eyepiece, then recording the angular differences between the slewed to 
coordinates and the manually centered coordinates.  Mapping a number of known targets 
allows the TPoint Telescope Modeling Software to analyze systematic errors in your 
telescope system and create a model to compensate for these errors.   
 
To begin a mapping session, accurately set your computer’s clock and establish a link to the 
telescope.. Once connected, slew the telescope to a known star and center it in the eyepiece.  
Using Find or Identify in TheSky, display the Object Identification dialog for the star. When 
the star information is presented on the Object Identification dialog box, click the Sync 
button in the Telescope Tab. Once this sync occurs, the telescope’s control system is 
aligned approximately with the celestial sphere. Even though this initial synchronization is 
never perfect due to imperfections in the system, it establishes the angles in the Paramount 
control system that all subsequent mapped stars will use.  
 
Important Note: During a mapping session do not re-sync your telescope control system by clicking the 
Sync button.  If you synchronize on a star after the mapping session has begun, you must start over! 
 
The sync star can also be your model’s first mapped point. Click the Map button to record 
this point and to begin gathering your pointing data. TheSky communicates continuously 
with TPoint as each map point is added.  
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From this point on, you should just have to slew, center and map stars to continue building 
the model.  
It is usually easiest to choose stars that are not far away from the Sync star until the first six 
points are mapped.  Once you have mapped the initial six stars, TPoint automatically begins 
compensating for systematic errors and you should notice an improvement in pointing 
accuracy. Finding the stars in the video (or other) feedback system becomes easier. 
 
The most efficient means of mapping points is to use a low light video camera coupled to 
the telescope.  With a video camera, stars to eighth magnitude are usually detectable and 
provide a large number of potential mapping targets. Also, the process of centering and 
mapping takes seconds, allowing you to perform a complete mapping session in under an 
hour. 
 
To Prepare For a Mapping Session 
1. Use the TheSky’s Time Service (or similar application) to accurately set your computer’s 

clock. 
2. Power up the Paramount.  
3. Make settings to TheSky to aid mapping.  For example: 

? ? Display only stars to sixth magnitude limiting screen clutter. 
? ? Turn on the constellation lines for easy identification and turn on the Meridian line 

to stay on one side of the sky while mapping (this is most useful for German 
equatorial mounts that must “flip” when going from the east to west and vice-versa). 

 
To Map an Object 
1. Identify a bright stellar object in TheSky. 
2. Instruct the telescope to slew to the above object by clicking the Slew button on the 

Object Identification dialog box. Make sure the correct object is highlighted in the 
Object Identification dialog box. 

3. Using the telescope’s joystick, center the object in your field of view. 
4. Click the Map button in the Object Identification dialog box. 
 
Repeat the above procedure for each mapped point.  For the best pointing results, map at 
least thirty to fifty objects distributed evenly across the entire night sky. If you are still 
working on the polar alignment, 20-30 stars with wide distribution should be sufficient.  
 
 

Troubleshooting 
 
Problem: I cannot communicate with the Paramount. 
Communication between a personal computer and hardware device requires that the 
software and hardware be properly configured.  If you cannot establish a link to the 
telescope, we recommend trying the following: 
 
1. Check the cables to the serial communications port (COM).  They must be securely 

plugged in at both ends. 
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2. Check the communications port with a different device.  For example, connect a 
different serial device to the port and insure it is working.  

3. Make sure the software settings are correct for the communications device (Telescope 
Setup Dialog).  

 
Problem: The Paramount is having difficulty slewing. 
Check the mount balance in both axes. 
If the Paramount stalls or sounds very labored as it is slewing, check to make sure both axes 
are balanced. The heavier the load, the more critical the balance becomes. Even though the 
control system has sufficient torque for moving heavy loads, tracking and slewing may 
suffer if the system is slewed greatly out of balance.  





 

Appendix A —  Preparing the Paramount Pier 
 
There are a number of options for attaching the Paramount to the pier:  
 
· Use a pier from Software Bisque, which is attached to the ground with 4 bolts. 
· Use an existing pier and attach an aluminum Universal Mounting Adapter. 
· Use an existing pier and attach a steel mounting adapter from Software Bisque. 
· Modify an existing pier to attach the Paramount Wedge by drilling and tapping the required 

pattern to accept the shoulder bolts. 
 

The Paramount is attached to a pier using three 5/16-inch shoulder bolts. These bolts form a 
triangular pattern. The wedge (and entire telescope) pivot around the hole that lies on the South side 
of the pier.  

Two slots at the front of the Paramount wedge assembly allow azimuth adjustment to the polar axis. 
The amount of adjustment is approximately two degrees on either side of center. Therefore, when 
the pier is installed, true North must be known accurately.  

 
The North side of the pier must be free of obstructions to allow for movement of the counter-
weight bar, approximately 30 cm (12 inches).  
 
 

 
Figure 17 - Bottom View of the Wedge Mounting Holes 

Figure 2 shows the bottom of the Paramount wedge. Note the slotted holes in the bottom plate that 
allow for making azimuth adjustments. Very fine thread adjustment knobs (not shown) are used to 
make adjustments accurately. 
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Required Hole Pattern for Attaching the Wedge to the Pier 

 

Figure 18 - Pier hole pattern to accept the Paramount Wedge 

 
Figure 3 shows the hole pattern required for mounting the Paramount Wedge. Each hole is 18 
degrees from a centerline that points directly North.  
 
An optional hole can be placed in the center of the plate (center 3.625 inches to the North of the 
rotation hole) for routing the Paramount electronic cable down into the pier. The hole diameter is 
one inch to allow passing of the Paramount cable and end connector.  
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Paramount Pier from Software Bisque 
The following information pertains to the steel piers manufactured by Software Bisque. 
 
Note the bottom plate of the Software Bisque pier contains 4 slotted holes with a radius of 6.25 
inches. This design allows the use of four 0.50-inch foundation bolts (such as j-bolts) placed in a 
concrete base. One edge of the base plate must be aligned with true North. The slotted holes allow 
for a few degrees of adjustment of the entire pier in addition to the 2 degrees of adjustment available 
on the wedge using the fine adjust screws of the Paramount. 
 

 
The pier base plate has a 6.25-inch 
radius for the mounting holes and an 
11x11-inch footprint. Software 
Bisque piers use the same plate for 
the top and bottom of the pier. On 
the top of the pier, the slotted holes 
provide a convenient place to hang 
various items. 
 
 
 
 
 
 
 

Figure 19 – Top and Bottom 
Plate of Paramount Pier  
 
 
 

The Universal Mounting Adapter 
A Universal Mounting Adapter pre-drilled with 
the Paramount Wedge hole pattern is available 
from Software Bisque. The plate also contains 3 
countersunk holes that can accept a ½  inch 
mounting bolts and nut. The center hole allows 
the Paramount electronic cable to be directed 
through the bottom of the wedge and into the 
pier.  
 
The large holes in the diagram accept the 
mounting bolts and the countersink is used to 
keep the nuts below the top mounting surface. 
Since the wedge slides on this plate when azimuth 
adjustments are made, the j-bolts must not 
protrude above the plate top. 
 

 

 
Figure 20 - Universal Mounting Adapter 
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Figure 21 - Mounting hole pattern for the mounting adapter 

The above drawing shows the dimensions of the mounting holes that are present on the Universal 
Mounting Adapter. The plate is machined out of 0.75-inch thick aluminum.  If mounting into a 
concrete pier, the best method of mounting the adapter is to attach the mounting bolts (probably j-
bolts) directly to it, then push them into the concrete while holding the adapter. The mounting bolts 
should not protrude from the concrete surface more than 0.75 inches, the thickness of the adapter 
plate. 
 
The center holes on the pier and wedge plates are provided as an option to route the electronics 
cable down into the pier. In situations where the wedge is attached to existing piers that do not 

provide a central pathway for the cables, the cables turn 
inside the wedge and exit through the front (North) side of 
the wedge.  
 
The drawing to the left shows a slightly overhead view of 
the Paramount. The top plate is used to attach optical tube 
assemblies. The dimensions of this aluminum plate are 9 x 
16 x ½  inches. This plate can easily be modified to accept 
many different optical tube assemblies. 
 
 
 
 
 

Figure 22 - Paramount side view showing OTA 
Mounting Plate 
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Appendix B —  Paramount Dimensions  
This section provides dimensions of the Paramount in the many possible positions used for pointing 
a telescope. German Equatorial telescope mountings are very stable by design, yet the requirement of 
counterweights increases the clearance space required surrounding the telescope and mount.  
 
 

 
Figure 10 shows the approximate 
dimensions (in inches) of the 
Paramount. The 14-inch dimension 
from the base of the mount to the 
center of the right ascension axis 
represents the approximate height of 
the OTA center when the telescope 
is pointed near the Meridian.  
 
For various latitudes the height in 
inches and can be computed from 
the following formula: 
 
 
 
 
 
 

OTA Center height at Meridian (see figure 12 below) =  
Metric: Height = 4.45 cm + sin(latitude + 32 deg) x 34.8 cm 
Imperial: Height = 1.75 in. + sin(latitude + 32 deg) x 13.7 in. 

 
This dimension is important if there are walls around the observatory building. An unobstructed 
view at the horizon requires the pier top be high enough so that OTA does not point through the 
walls when pointing in the North or South directions. 
 
Latitude Approx. OTA Center height at Meridian (inches) 
20 11.5 
30 13 
40 14.5 
50 15 
 
 

 
Figure 23 - Approximate Paramount Dimensions 
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The widest dimension of the Paramount (i.e. looking North-South) is 12 
inches, the width of the right ascension gear cover when the declination 
assembly is vertical. 
 
 
 
 
 

 

 
Figure 25 - Perspective drawing of the Paramount with a C-14 tube assembly. 

 
 

 
Figure 26 - Approximate width is 47 inches with a C-14 tube attached. 

 
 
 

 
Figure 24 - Width 
of the Paramount 
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Appendix C —  Paramount GT-1100S Cabling 
The Paramount GT-1100S has been designed to simplify the process of routing cables to 
many common electrical devices, such as CCD cameras, filter wheels and focusing motors.  
For most applications, it is possible to pass all electrical connections through the 
Paramount’s internal wiring, eliminating the danger of disconnecting or even breaking wires 
during mount movements. 
 
Before making any connections to either the BASE PANEL or INSTRUMENT PANEL, 
the following information should be read and understood.  Failure to observe stated 
procedures and limitations may result in damage to the Paramount’s control electronics 
and/or any attached auxiliary devices. 
 

Panel Connector Descriptions 
 
Connector Type Notes 
BASE PANEL   

Mount Power DC power input 48 VDC tip positive, 1.2A (fused) 
Power supply is intended for 
indoor use only.  

Camera Power DC power input +12VDC, 2A; -12VDC, 1A; 
+5VDC, 1A 

Aux Power 1 DC power input 5-125VDC, 5A (fused) 
Aux Power 2 DC power input 5-125VDC, 2A (fused) 
Parallel Parallel data 

input/output 
Host PC-to-Mount 
communications 

Serial Serial data 
input/output 

Host PC-to-Mount 
communications 

Aux Serial 1 Serial data 
input/output 

Auxiliary communications pass-
through‡ 

Aux Serial 2 Serial data 
input/output 

Auxiliary communications pass-
through 

INSTRUMENT 
PANEL 

  

Camera Power DC power output +12VDC, 2A; -12VDC, 1A; 
+5VDC, 1A 

Aux Power 1 DC power output 5-125VDC, 5A (fused) 
Aux Power 2 DC power output 5-125VDC, 2A (fused) 
Focus DC power output 12VDC†, 1A* (fused) 
Guider Dual-axis input Four open-collector TTL logic 

inputs 
Parallel Parallel data 

input/output 
Mount-to-device communications 

Serial Serial data 
input/output 

Mount-to-device communications 
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Aux Serial 1 Serial data 
input/output 

Auxiliary communications pass-
through‡ 

Aux Serial 2 Serial data 
input/output 

Auxiliary communications pass-
through 

†Jumper JF1 on the piggyback Adaptor Board may be used to select 5VDC or 12VDC operation of the 
focus motor.  Variable resistor R1 on the same board may be used to fine-tune the speed of the focus 
motor. 
‡Aux Serial 1 has pins 1-9 wired straight through, which may be useful for non-communications 
applications that do not exceed 1 amp per conductor.  The other serial connector (3-wire) has only 
pins 2, 3 and 5 wired. 
 
 

DC Power 
 
CCD Camera 
 

ST-4, ST-5, ST-6, PixCel 255— The Aux Power 1 (5A) jack can be used to power the 
CPU and head.  A cable will need to be made to adapt to the CPU’s power connector.  
Construct two 5.5mm O.D./ 2.1mm I.D. DC power plug-to-DB9 adaptor cables— wiring 
the sleeve to pin 4 (GND), and tip to pin 9 (+12-15VDC).  Use a DB9P (male) for the 
BASE PANEL cable, and a DB9S (female) for the INSTRUMENT PANEL cable. 
 
ST-7, ST-8— The Camera Power jack can be used to power one of these cameras.  Plug the 
camera’s power supply into the BASE PANEL’s Camera Power jack, and a 5-pin DIN 
(180°), male-to-male cable, wired straight through, between the INSTRUMENT 
PANEL’s Camera Power jack and the camera.  Do not use less than 22 AWG wire for this 
cable, or the camera may not be able to draw enough current for thermal regulation (24 
AWG wire may be used if two conductors are ganged for the GND line). 

 
Focuser 

A low-amperage (250mA) motorized focuser may be software-controlled through the 
INSTRUMENT PANEL’s Focuser jack.  This jack accepts the industry-standard 3.5mm 
phono plug.  The power applied to this jack is reversing DC, of user-selectable voltage.   

 
 

Communications 
 
Paramount   
 

Serial— Connect a DB9 female-to-female cable (included) between the Serial connector 
on the BASE PANEL and a serial port on the host computer. 
 
 

Instrument-mounted Device  (e.g. CCD camera, closed-loop focuser, etc.) 
 
Direct (serial)— Connect the serial communications cable from the device to one of the 
Aux Serial connectors on the INSTRUMENT PANEL.  Connect a DB9 female-to-female 
cable between the corresponding Aux Serial connector on the BASE PANEL and a serial 
port on the host computer.* 
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Guider 
 
The Guider jack accepts an RJ12 modular plug, and provides external access to the 
directional switching. 

 
RJ12 pin Color* Description SBIG DB15 pin† 

1 BLU +X (R.A. “East”) 10 
2 YEL +Y (Dec. “North”) 13 
3 GRN –Y (Dec. “South”) 7 
4 RED –X (R.A. “West”) 4 
5 BLK GND (common) 5,8,11,14 
6 WHT N/C (no 

connection) 
 

*Note: The actual wire colors may differ, depending upon their 
placement within the RJ12 plug. 
†This information may be used with ST-4, ST-5 and ST-6 cameras. 

 
 
 

Radio Shack® Cross Reference 
 

Description Part 
Number 

Qty./P
kg. 

1A 5x20mm fast-acting fuse 270-1049 4 
2A 5x20mm fast-acting fuse 270-1052 4 
5A 5x20mm fast-acting fuse 270-1056 4 
5.5mm O.D./2.1mm I.D. DC power 
plug 

274-1569 2 

3.5mm phono plug (mono) 274-286 2 
RJ12 modular phone plug 279-421 10 
DB9P (male) 276-1537 1 
DB9S (female) 276-1538 1 
DB9 hood (used with DB9P and 
DB9S) 

276-1539 1 

DB9 female-to-female cable, 6 ft. 26-152 1 
DB25 male-to-male cable, 6 ft. 26-249 1 
DB9P-DB25S adaptor 26-287 1 

 
 

1 2 3 4 5 6 
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